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Welcome
-

Congratulations on purchasing
FairOption!
The Gold Standard Option Pricing Calculator
(since 2014)
-

Available for Mac, iPhone, iPad and Apple Watch!

Originally designed in 2014, the most recent FairOption version
3 now adds many improvements while including the latest
Apple technologies.
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The App is super-powerful, flexible and easy-to-use, being
completely rewritten using the latest SwiftUI framework, first
introduced by Apple in 2019.
And it works great, both in light and dark modes.
The new 2022 FairOption App, while providing a fully
interactive option pricing experience, is now available on all
Apple devices. You can use it stand-alone on a single Apple
device or integrate the App between diﬀerent devices. The
App is available for purchase on a per-platform basis. i.e. you
could purchase it first just on iPhone or on Mac, and then add
it to the other platform, also to Apple Watch. Whichever
device or combination you choose for the App, FairOption has
been custom designed to take full advantage of each
platform’s strengths.

Fast, accurate independent options pricing is now right at
your fingertips, without reliance on an outside connection
or trading system.
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Stock and Index options with American and European-style
exercise are all covered. Monthly option cycles and all
quarterly expiry types too, as are the shorter-term Weeklys and
longer-term LEAPS option variants. Expiry days can be
defined for all new securities you add and then overridden on
an individual basis for the third Friday or last weekday of the
expiry month for any option cycle.
Calculations are fast, Black-Scholes and Binomial models
are included and all calculations are dynamic. i.e. you change
any parameter for the security, calculation model or other
variable and then quickly see the updated results. The
interface is fully interactive. In the options screen, one tap on
the top-left red/green cell toggles between Calls and Puts and
a single tap on any option price result drills straight down to
the option Greek values.
Option pricing results are displayed in a two-way scrollable
grid (horizontal and vertical scrolling, even on Apple Watch!)
displaying option expiry columns and exercise price rows. On
iOS, the scrollable tables work well in both portrait and
landscape modes, and on Mac, with a further click, a tabular
(‘spreadsheet’) format displays option price result rows which
can easily be sorted on any column (including Greeks). This
tabular option data is exportable to either a JSON or CSV file
for opening in Excel, or other use if desired.
And as with all great Mac Apps (because of the extra
processing power and screen space), they can always do that
little bit more than on other devices. So on Mac, you will be
able to open multiple security windows at the same time as
separate windows (or consolidated in a single window using
multiple tabs) just like all the other Mac Apps you love and use
everyday (e.g. Safari browser.)
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Plus for each security on Mac (whether in tab or window) you
will be able to see all three information panes at the same time.
i.e. the securities list ‘sidebar’, the scrollable options grid or
table, and the Greeks simultaneously, all in one view!
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The chief developer takes great care and pride in his work,
always going those extra Miles. (Maybe it’s all in ‘a name’ :-)
The main developer’s experience with option trading software
goes back over 30 years, as he was originally involved in the
development of option pricing systems, together with
investment software marketed by the London International
Stock Exchange in the 80’s. (About 10 years after the ‘Nobel
laureate option pricing models’ were first recognised and the
binomial model was first proposed)
FairOption is designed with total ‘software passion’ and care,
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as development is extended to a point where any Apple user
can now quickly and easily have the theoretical fair value of an
option at their fingertips, on phone, desktop or wrist, anywhere
in the world without reliance on a network connection, or other
service. Our attitude is ‘if it can be done’ then let’s do it now,
and provide customers with the very best.
Even better, FairOption now includes full automatic Cloud
sync integration of your latest securities data between all
your Apple devices. (including Desktop Mac, MacBook, iPad,
iPhone and Apple Watch). We stress, this is automatic and you
do not need to manually synch or set up anything extra after
installing the App! (But you do need to be signed in to iCloud,
which most users are anyway)
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So your latest stock security additions and edits only ever
need be recorded once on any single Apple device.
We even added a facility to export and import your raw
security data to and from a local device or cloud storage if you
prefer a personal backup in addition to the working App data
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already automatically stored on your local device (and
optionally in Apple iCloud). Cloud sync is extremely smooth
and reliable, but some may still want a ‘personal hard copy’ of
their main securities data as a ‘snapshot’ backup in time, with
the ability to restore it if required. So we include the facility.
For new users, a menu utilities option is provided to quickly
import a simple small example demo data set of securities
while you test and get familiar with the main functions of the
App. Not all apps have decent help included with them, but
this comprehensive help document will get you quickly ‘up to
speed’, usually without any need to go online. Please carefully
read the Quick Start Guide section before using the App for
any serious option pricing. If you have the Mac, iPhone or
iPad version of FairOption then the help is available without
going online. If you have the Apple Watch version (and no
additional device version) then you will need to access the help
document at FairOption.com (Watch is not really suitable for
displaying detailed pdf or help documents)
Thank you once again for choosing the best option pricing
software on the top and most secure Apple platform.
We would love to hear feedback of your experience using
the App and invite your suggestions for any features you
may want added to the next version of FairOption.
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What's New
-

New features and improvements include:
✓ FairOption can be used on numerous Apple devices
including Mac, iPhone, iPad and Apple Watch.
✓ Complete re-write in SwiftUI.
✓ Automatic Cloud Sync of all your securities data across
all your Apple devices.
✓ Import/Export of Securities data. (facilitating independent
local backup and restore via the JSON file format.)
✓ Included demo data utility for testing and familiarity
purposes.
✓ All Option results tables are scrollable in both directions
and fully interactive.
✓ Export of Options calculation results table data to JSON
or CSV. (Mac Only)
✓ Short-term Weeklys and longer-term LEAPS option expiry
variants are specifically catered for.
✓ Improved, faster switching between Call and Put option
results.
✓ Included Continuously Compounded Interest Calculator
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for easy calculation of risk-free interest rate.
✓ Editable default template for all new securities you add.
✓ Many other technical improvements. (See video)
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Quick Start Guide
-

All users are advised to take a few moments
before using the App to read this Quick Start
Guide
This guide outlines the main features of the FairOption App.
Please also read the sections named Important, App Settings,
Utilities and Add/Edit Security before using the App for any
serious option pricing purpose.
Note: This help document covers all Apple devices (not just
Apple Mac). To start with a small set of demo/test data while
getting familiar with FairOption. See import demo data in the
Utilities section.
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-

Main Interface Elements (Mac illustration)
Most of the App interface elements (unless otherwise
described) are accessed similarly on each device (iPhone,
Mac, Watch etc.)
▪

(1) Securities List: All securities stored are available by
selection from the main securities list that first appears
after App launch. Either scroll up and down and select, or
type within search box (13) and select from the resulting
list. Clicking on any security will display its options in a
scrollable-grid format. On Mac, the sidebar securities list
can be hidden or displayed using ! (5). (Or resized by
dragging the boundary between 8 and 1.)

▪

(2) Add New Security: selecting this ‘+’ icon will enable
you to add a new security (subject to the initial security
defaults already set in ‘Security Defaults Settings’. See
Add/Edit Security

▪

(3) Edit Existing Security: On Mac, Click the " icon to
make changes to the currently selected security record.
On Watch and iPhone, you need to first select edit mode
via the " icon (It then flashes green on iPhone and Watch).
Then select any security via scrolling or search, to edit the
record. Remember: to turn oﬀ edit mode when you have
finished editing security records. (It will be quite apparent
if you forget, because any security you tap will display
security details vs option results). See Add/Edit Security

▪

(4) Delete Existing Security: On Mac, Click the # icon
to delete the currently selected security, highlighted in the
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security list (1). The App will then double-check if you
really want to delete that security record.
To delete on iPhone/iOS and Apple Watch, just swipe to
to left on any security in the security list that appears as
the first screen of the App. Note that a full left screen
swipe on iOS iPhone will immediately delete the security
without and chance to cancel the action. A smaller/
shorter swipe will provide a check before the deletion.
To delete all securities in one go see: Delete All Securities
in Utilities
▪

(5) Hide/Show Securities sidebar: Mac (and iPad
landscape-mode) only. Click the ! icon to show or hide
the securities list (1) at any time. Hiding the list provides
more screen space for the main option results. On Mac,
this ‘Toggle Sidebar’ function is also available from
FairOption’s main menu or via the ^ + cmd (!) + S
shortcut keyboard combination.

▪

(6) Security Name: Displays current security or index
selected together with the underlying price currently
being used for option pricing.

▪

(7) Calls/Puts selection: Use this top-left cell button to
select between displaying Calls and Puts on iPhone and
Watch and when in the Grid mode on Mac. If you already
have a scroll position and specific option selected within
the results grid (9), then using this Calls/Puts toggle
should still maintain that position within the grid making it
easier to compare call and put option prices of the same
expiry date and strike price. The cell is green when calls
are being displayed and red when put options are visible.
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Note: If not in ‘Test Calc Mode’, then changing from Calls
to Puts and back again to Calls, with even a small amount
of time passing in between, may result in diﬀerent option
price result values for the same call or put, between the
first and second viewing of the same option! This is no
error re option prices are time dependent.
▪

(8) Row Headers: (The strike column). The row headers
column displays the strike (exercise) prices for all the
options in the main option grid (9). These strike prices are
by default automatically generated based on factors such
as the underlying security price. But the numeric interval
between strike prices can easily be overridden for a
security at any time on any device by tapping on any cell
in this row headers column (8) and selecting a new
override interval to coincide with the particular options
you are pricing.
Please note: that if you override the strike interval for a
security then that override will stay in eﬀect for the
security on all devices until cancelled. To cancel a strike
interval override, just tap/click again in (8) and choose
‘Auto/Oﬀ’.

▪

(9) Options Grid: The main option Grid displays by
default all theoretical call or put fair option values for the
selected security. Tapping on any cell within the grid will
then ‘drill down’ to display that option’s Greek sensitivity
values. The options grid is scrollable in all directions if
there is not enough screen space to display all the
options for the current security. Options with strike prices
closest to the underlying security price (nearest to ‘at the
money’) are indicated by a shade of grey (vs black)
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Option List/Table: On Mac only, as described in (11), it is
also possible to display a list of call and put options
including some greeks all in a single list via the Option’s
List icon (11). This list (or table) can then be scrolled and
sorted on columns by clicking on any column’s title
header. (with another click reversing the direction of the
sort). Use icon (12) to revert to the original Grid format.
Note: A Greek result of ‘nan’ in the options list table or
Greeks results window pane means that the particular
greek cannot be calculated from the current parameters.
‘Nan’ stands for ‘Not a number’. For example: if you
enter zero for any underlying stock value (which is
obviously nonsense) then you will get numerous ‘nan’
results for the greek values because they are impossible
or meaningless to calculate.
▪

(10) Expiry Column Headers: The row at the top of the
options grid displays the expiry dates (including weekday)
of all the options of the various strike prices within that
column. Please note that to scroll the options grid to
reveal more options of diﬀering strike/exercise prices and
expiry dates, you will need to scroll/drag within the main
options grid. i.e. Not on the expiry column headers row
(10) and not on the row headers column (8).
The Expiry Column headers row in the Grid is probably
the only non-interactive part of the interface. (i.e. clicking
on it will have no useful eﬀect)

▪

(11) Options List (Table): (Mac only) On Mac only, it is
also possible to display a list of call and put options all
contained in one scrollable list via the Option’s List icon
(11). You can still select any option price row to reveal its
Greeks in the right-most pane. This list can also be
scrolled and sorted on columns by clicking on any
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column title header. (with another click reversing the
direction of the sort). Use icon (12) to revert to a Grid
format.
Once in ‘Mac list/table view’ and when the list is
displayed and sorted how you choose, there is additional
facility to export all the option price data for the security
in CSV or JSON file format. (maybe for import into a
spreadsheet or other application).
Please note that this facility is not available on iOS or
watchOS re Apple have not yet included the SwiftUI table
technology for iPhone or Watch. Only for macOS. And on
Mac, the table columns are presently limited to the
display of ten scrollable columns due to an Apple SwiftUI
limitation. However with any export you perform from the
list/table view on Mac, we have worked around this
limitation, and all option fields are still exported to file. i.e.
You set the order within the table, and then all calculated
option data columns and records for the security are
exported in that same order to your file, either in CSV or
JSON file format.
▪

(12) Options Grid icon selection: All devices display the
options Grid/lattice by default when any security in (1) is
selected. The resulting Grid of options is fully scrollable in
all directions if appropriate and all options within the grid
are selectable via a click or tap to reveal more
information.

▪

(13) Search for security: There is a security search
facility on all devices (separate from the normal scrolling
method of browsing). On Mac, it is in the top right
position. On other devices it is near the top of the first,
securities list screen. On Watch, it is near the top of the
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first App screen under the main securities control icons,
but you may need to tap the word ‘securities’ to get quick
access to it. In the search box, you can type anything you
know is contained within the security’s name i.e. typing
‘Index’ would find all securities that have ‘Index’ within
their security name, even though it is commonly not at the
beginning of a security name. Once the search brings up
a list of matching results, you can tap on one of those
results to display the security’s option calculations.
▪

(14) Tab View: (Mac only) On Mac only, you can open
multiple windows with each one optionally displaying the
options of a diﬀerent security. Simply choose File -> New
from the main menu to achieve this or alternatively use
the cmd (!) + N keyboard combination shortcut or the
‘+’ button at the right of the Tab bar (14) if it is already
displayed. Multiple Windows can be shown as Tabs
within a single Window by choosing the Window ->
Merge All Windows menu option. And any Tab within a
Window can be moved to a completely separate Window
by right/context clicking on the tab within the tab bar and
choosing the ‘Move Tab To New Window’ menu option.
This all gives maximum flexibility to deal with multiple fair
value option tables simultaneously.
Please note: that the Tab bar is always displayed when
there is more than one tab in operation within a Window.
Otherwise it can be hidden or displayed using the View ->
Hide/Show Tab Bar menu option.
Also note that on Mac, all three column panes (securities
list left sidebar pane, scrollable options grid middle pane,
and the greeks right pane) of a window are resizable by
dragging between any of those panes.
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▪

(15) Greeks: on Mac, the right-most window pane
displays the Greek sensitivities associated with the
currently selected option (9). On Watch and iPhone the
Greeks fill the screen and are scrollable. A Tap on any
Greek will then display a description of the Greek (below
the Greeks on Mac and iPhone, or directly overlaying the
Greeks on Watch, with another tap anywhere on Watch to
dismiss that overlaid description).
Greek sensitivity values are very useful and indicate the
degree to which the option values are expected to vary
depending on changes to various parameters.

▪

(16) Greek Descriptions: are displayed by tapping on
any Greek. A Tap on any Greek displays a description of
the Greek (below the Greeks on Mac and iPhone, or over
the Greeks on Apple Watch, with another tap anywhere
on Watch dismissing the description and returning to the
original option results)
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App Settings
-

$ Preferences / Settings (including Utilities on
Mac and iOS)
It is recommended to ensure App preferences / settings are set
appropriately before using the App for any serious option
pricing. (But it will not matter if you are just testing and getting
familiar with the App using the provided test demo data).
To import test Demo Data, see Import demo data within the
Utilities section.

- 23 -

- 24 -

▪ On iPhone or Watch, select the gear " icon , to

access the settings / preferences. On iPhone, three
settings screens are then available via tab selections at
the bottom of the screen. With Watch, you have access to
two settings screens by swiping left and right.

Update: On iOS (iPhone and iPad) there are
now four icons available (on the bottom row,
within the securities list screen) due to the
addition of the oﬄine help document icon, now
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accessed via the right-most and fourth icon.

On Apple Watch, If you have already
scrolled down the list of securities so the top icons
are no longer visible, then just tap on the word
‘Securities’ at the top of the watch screen, and all
three main control icons (with search) will quickly
become visible again.
▪

On Mac, from the top left/first menu, select Preferences.
(or use the !, shortcut key combination. i.e. the Apple
cmd key combined with the comma key.)

▪

On iPhone and Mac, there are then three tab menu items
within the settings. Watch has two settings screens and
no utilities screen.

▪ To dismiss any settings screen when you are
finished:
▪

on Mac: just use the window’s top left small round red
close button.

▪

on iOS/iPhone: swipe down or tap the close button.

▪

on Watch: select any close button within a settings
screen or tap the top-left navigation arrow. (Remember:
that to switch between the two setting screens on Apple
Watch, just swipe left and right)
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-

% Calculation Settings
▪ Option Calculation Model: This is the current option
pricing model you select for all option calculations and
which can be periodically changed to meet current
requirements.
If the Binomial model is selected, only then will you get a
choice for the number of steps used in calculations (since
the Black-Scholes model does not use discrete, iterative
steps at all, but uses ‘continuous time’ mathematics to
achieve its pure, exact results under the assumptions it
makes.)
With the more flexible binomial model (first proposed by
Cox, Ross, and Rubenstein in 1979), more binomial steps
commonly mean more binomial accuracy (although It is
not a completely linear relationship.) But more steps
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means that calculations are slower to complete. BlackScholes is much quicker but is less appropriate for the
valuation of American exercise-style options, where unlike
with European-style exercise options, there is the
possibility of early exercise before expiration.
Note: Index options are cash settled and commonly
European exercise style, and in which case cannot be
exercised before expiry.
So in short, Black-Scholes is usually much quicker, but
only totally suitable for European exercise-style options
because they can only be exercised at expiry. However,
Black-Scholes can still produce very good results for
American Options when the possibility of early exercise is
remote i.e. non/low-dividend paying securities when the
options are not deeply ‘in the money’ (i.e. do not have
high intrinsic value.)
Try both models and compare the results to get a feel for
the diﬀerences involved.
Please note: The original Black-Scholes model was only
applicable for pricing options on stocks which did not pay
any dividends. However, FairOption uses an extended
Black-Scholes-Merton model (sometimes still referred to
as ‘Black-Scholes’) which does make adjustment for
dividends, with the assumption that the dividends are
paid on a continuous basis. For more detail on the
dividends parameter, see the section on dividends within
the Add/Edit Security section.
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On Apple Watch, use the Apple Watch’s
digital crown to adjust the number of binomial
steps, after selecting ‘calculation settings’, the
binomial model and then tapping on the binomial
calculation steps control box. This will provide a
finer degree of adjustment.

▪ Risk-free interest rate: The percentage interest rate
parameter entered here will always be used for all
FairOption option calculations. The figure accounts for
the fact that an option buyer ‘lays out’ money when
funding a trading position and therefore to a degree
‘looses out’ on the return that same money would have
made if invested in a risk-free security. E.g. a government
bond or bank guaranteed interest account. (Yes nothing is
theoretically risk-free, but this is meant as a good
approximation to a risk-free rate of investment)
▪

The interest figure entered here for the model calculations
must be a continuously compounded annual
percentage risk-free interest rate available for cash
deposits. ‘Continuously compounded’ means that the
interest returned on the money is continually merged/put
immediately back into the risk-free investment, just as it is
generated, for yet more (exponential growth) return. Be
careful, re most rates are listed relating to simple flat rates
of interest, but all will definitely be explained below:

▪

Please note: that interest rates are not normally a large
significant determining factor in option pricing unless the
option contract period is quite lengthy. Interest rates also
tend to be quite stable/constant over the period of an
option contract. (And this is actually an assumption
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inherent in the option pricing models.)
▪

The interest rate figure commonly used is ‘taken’ from the
90-day Treasury bill rate (or 30-day T-bill for shorter
options). Other longer term Treasury bond rates are
sometimes used when option contracts are longer. And
some traders average numerous Treasury bill rates for
terms which coincide most with their current trading
timeframe. Be careful of the units used though, as a
simple flat interest rate of return figure over 90 days is no
good. It needs to be a continuously compounded
percentage rate figure. (see below)

▪

Example, concepts and a useful Formula:
A real Government-debt Treasury bill does not actually
pay any ‘conventional interest’ at all. Instead, a T-bill is
usually quoted and sold to a buyer at a discount to its
face (or par) value (redemption price) that will be paid to
the holder of the bill at the bill’s maturity. So in eﬀect, the
initial purchase discount benefiting the buyer of the bill at
maturity, ‘equates’ to ‘the interest’.
E.g. US T-bills are priced per $100 face value. So a 90day T-bill with standard denomination $1000 face value
selling for $980 would be quoted at a price of 980 /
(1000/100) = $98 cash price (per $100 face value.) i.e.
$980 to buy the T-bill with $1000 face value. (or a 2% rate
of discount oﬀ the face/future redemption value)
So for that ’90-day to maturity’ T-bill:
The return over the 90-day period = 100 x (100 - 98.0) /
98.0 = 2.041% return
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But the 2.041% is not an annual return and it is also a
simple (flat) interest rate of return. Option pricing models
assume a continuously compounded risk-free interest
rate figure. (i.e. that the returns are continuously always
reinvested as soon as they are generated)
So how do we convert from a simple flat interest rate to
continuously compounded interest?
In the above example, we ‘do’ already (you may think!)
have a completely reasonable, risk-free rate figure for
return over a known period of time using a simple flat rate
of interest paid once. i.e. the initial deposit amount is
known, the length of time to maturity is known, and the
final redemption amount of the T-bill at maturity is known,
all with great certainty.
Therefore now we need to use (and then rearrange) the
continuous compound interest formula. Yes this could
involve some maths! Yuck :-) but at least not here
anything like the complexity of the advanced
mathematics associated with the Nobel-prize winning
option pricing theory, applied and extended behind the
scenes within FairOption!
The continuously compounded interest formula below, its
discovery and derivation does involve some beautiful and
hugely important mathematics. The ‘e’ number used
within, is one of the most important constants in many
spheres of mathematics, engineering and in life. It is
credited to Leonhard Euler, also being known as Euler’s
number, maybe due to the fact he was the first to
calculate it more accurately.
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But Leonhard Euler, although he was a completely brilliant
mathematician, did not discover it!
No, about 25 years before Euler was even born, the Swiss
mathematician, Jacob Bernoulli (of statistics, probability,
and calculus fame) in 1683 discovered the ‘e number’
when posed with trying to solve a problem about a
financial topic.
That subject?
Compound Interest (in the limit, when compounding then
becomes completely continuous and always approaches
a constant number)

The formula is: A = Pe^(rt)
where,
A
- is the final absolute cash amount returned at the
end of an investment period. (= $1000)
P
- is the initial cash amount invested at the beginning.
(= $980)
r
- is the continuously compounded rate of interest as
a fraction (i.e. 10% would be an r of 0.10)
t
- is the time frame in years corresponding to the time
between the A and P values
e

- is Euler’s number (approx 2.718282, But you will
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not need it here when the equation is simplified using
natural logs)
^
- just means ‘to the power of’ i.e. P multiplied by (e
to the power of (r multiplied by t))

So for our initial T-bill example:
1000 = 980 x e ^(r x 90/365)
values in the equation

by placing our initial

1.020408 = e ^(0.246575 x r)
by 980

by dividing both sides

LN(1.020408) = 0.246575 x r
by taking natural
logarithms (LN) of both sides of the equation
r = LN(1.020408) / 0.246575
equation gives us r, as a fraction

rearranging the

r = 0.08193
via a calculator with
logarithms, with the result as a fraction (vs percentage)
=> continuously compounded rate of interest =
0.081935 x 100 = 8.193%
(Admittedly here, in this particular made-up example, you
could have chosen to use the original simple flat rate of
return of the T-bill over 90 days (i.e. 2.041%) and then
taken that figure on a ‘pro-rata’ basis over the time period
of a year making 2.041 x 365/90 = 8.277 %. But that is
not a continuously compounded rate figure and is not the
correct method on a number of counts. And other
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examples with fixed interest Treasury bill returns over
diﬀerent time periods may well reflect larger diﬀerences)

In short: when you have access to reliable and trusted
risk-free, flat/simple interest rate investment data,
conforming to an initial outlaid amount and a known total
payout at a known maturity date, that corresponds to
your option investment time frame: then the formula to
use, consistent with the option pricing models, if basing
your interest figure on that risk-free security data is:
Continuously compounded rate of interest in % = 100 x
LN(A/P) / (t/365) where LN is the natural logarithm to
base e (not the common logarithm to base 10)
This is a relatively simple calculation on any modern
calculator. (Even my old FX-81 from 100 years ago can do
it :-)
But be careful of the input data: Treasury bills can be
quoted in numerous ways that can cause confusion, or
seem to distort their perceived return. E.g. Treasury bill
return rates are often quoted assuming a 360-day year,
and most quotes refer to a percentage discount rate
based on the face value at maturity. If this rate were
taken as a percentage return, it would understate the real
return. A true rate of return over a known period of time
should really be based on the additional money earned
over that period, divided by the initial total money
invested. E.g. a T-bill quoted at a 10% discount to face
value would actually deliver a 100 x (10 / 90) = 11.11%
return at maturity. (i.e. more than a 10% diﬀerence to the
quoted discount rate!)
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Also be careful because we have noticed that numerous
continuously compounded interest rate calculators
appearing prominently on the web (commonly peppered
with numerous Ads about just about ‘everything you
searched for in the first place’ :-) , and very high up in
search engine results, then produce figures which result in
substantial inaccuracy. Perhaps prominent results that
inappropriately relate to a search, or links that return bad
data are an ever increasing problem now? But in any
event, you do need an accurate continuously
compounding interest rate calculation together with
appropriate and accurate input parameters you trust to
use in that calculation.
We do always like (where possible) to help and simplify
more complex subjects for our users, but sometimes ‘a
little knowledge can be a dangerous thing’. i.e. It is
important to have some understanding of where a figure
should come from, and know if a parameter is accurate
and suitable. So our own continuous compound
interest calculator has now been included and
integrated with all device platforms of FairOption 3! It
is accessible directly from the ‘Calc Settings’ screen, just
below the ‘Risk-free Interest rate’ input. This means you
no longer have to rely on some ‘spurious calculator’.
FairOption’s own Continuous Compound Interest
Calculator: This is designed specifically to base your
inputs on some representative T-bill, bond, or other
trusted risk-free asset. Then it can provide you with a
continuously compounded rate of interest result to use in
your option price calculations. (But as described above,
you do still need accurate, up-to-date input parameters!)
Please Note: Just running our included interest calculator
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does not automatically enter the resulting value as the
risk-free interest stored in FairOption’s ‘Calc settings’
screen. i.e. The calculator will still need you to manually
enter the rate figure if you are happy with the calculator’s
input parameters. (To get familiar, test the calculator out
first with the made-up T-bill example above. Then obtain
some decent, up-to-date, real figures from your chosen,
representative, risk-free interest asset)
▪

Test Calc Mode: can be switched on or oﬀ (usually kept
oﬀ) and enables you to enter a fixed number of years until
expiry for subsequent option calculations.
When turned on: you will see that any security only
displays options for a single expiry date corresponding to
the number of years you set from todays current date and
time. The ‘Test Calc Years’ input field accepts decimal
numbers like 1.0 and 2.3543. No expiry dates will be
calculated on any ‘third Friday of month’ or ‘last weekday
of month’ basis. The option expiry is now set purely
based on the figure you enter for the number of years
from now.
The purpose of this ‘Test Calc Mode’ override facility is to
provide a useful way to test, confirm and compare option
pricing model calculation results between FairOption and
other systems (including numerous ‘text book’ examples)
where an absolute time to expiry is usually a required
input parameter. (vs particular expiry dates on particular
days).
Example: To match an option calculation for options
expiring in 60 days from now: In ‘Test Calc’ mode you
would enter 60/365 = 0.16438 in the ‘Years’ field. Note: In
Test Calc Mode, all other non-expiry-related calculation
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parameters are still taken and used as normal from the
calc settings and specific security record.

-

& Securities Defaults Settings
This settings screen holds the current defaults used for
securities you subsequently add. i.e. Every new security record
you add to FairOption will start with these current default
setting parameters. Yes you can easily override all parameters
as or after you add a new security, but this facility is meant to
minimise input and to provide sensible starting parameters for
all the securities you add.
Notice that the screen also includes defaults for options on the
particular security.
▪

For example: You may mostly be interested in American
options and always want to see theoretical fair option
values for all months and never deal with any Weeklys or
LEAPS expiry variants. So in such a situation, setting the
defaults here accordingly will mean that when you add
each new security to FairOption, it will automatically start
with those initial setting, until you override them in their
individual security record. (i.e. they start with Weeklys and
LEAPS turned oﬀ and the American exercise-style set).

▪

Please note: that editing these Security Defaults in
settings never changes any parameter for any of the
existing security records already added. Edits of the
securities defaults settings here only ever aﬀect the initial
starting values of securities added after you make a
change to the securities defaults.
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Utilities
-

' Utilities (Mac and iOS only)
Utilities are accessed on iPhone/iOS via the settings gear "
icon, followed by selection of the right tab at the bottom. And
on Mac, from the top left/first menu, select Preferences. (Or
use the !, shortcut key combination. i.e. the Apple cmd key
combined with the comma key.) Utilities is then the right-most
tab.
The vertical menu of flexible utilities helps to manage your
security records. Please use Utilities with care and read this
guidance before use. The utilities are currently not included on
Watch as they are more suitable for larger devices with more
segregated storage, and most users who have Apple Watch do
also have an iPhone. (Therefore the same securities data is
then synched between the two devices and the utilities and
data are accessible from iPhone)
⁃

Export ALL Securities to CSV file: This provides a data
export of all your securities record data to a CSV (comma
separated value) file with a .CSV file extension. This file
contains all the rows of your securities with each
security’s parameters separated by commas. The file
also contains a header record in the first row describing
the data within each ‘column’ and it will easily import into
spreadsheets such as Excel by selecting File -> Open,
selecting and loading the .CSV file. To then improve
display after import, select the whole sheet by clicking in
the top left corner of the spreadsheet (to the left of A, and
above 1), and then double-click between any column
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alpha- character header. e.g. exactly between A and B in
the spreadsheet header above 1. This should quickly size
all the columns appropriately.
Please note: Exported Securities CSV files are not meant
to be imported back into FairOption and are not designed
for backup purposes in a way that can be restored. (For
technical reasons, we have designed the JSON file
export/import utilities for that purpose.)
⁃

Export ALL Securities to JSON file: This provides a data
export of all your securities record data to a JSON
(Javascript Object Notation) file with a .JSON file
extension. This dated file contains all your security data
in a more coded format and it is designed to be used as a
valid backup of all your FairOption securities. i.e. you can
export a dated snapshot of your securities data at any
time to cloud or local storage (in addition to the current
working securities App data already stored on your device
and the synch data within Apple iCloud.) Many users are
understandably not happy using an App which does not
allow a genuine independent personal backup of their
own data.

⁃

Import Securities from JSON file: This utility routine is
designed to import any JSON Securities file originally
exported by FairOption in JSON format, and therefore
can be used to restore Securities previously exported to a
JSON file, made at some previous point in time by you
using The FairOption App.
Please note: This utility adds the imported securities to
any securities that are already there within FairOption on
your device. (So to do a total restore, you may first want
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to use the ‘Delete all securities’ utility routine first.)
⁃

Import Demo Securities: This utility menu option is
intended to add a small set of demo data to FairOption
for you to test and become familiar with the App. We
could have just given you reference to a JSON file on the
web to download and import, but this makes it easier to
add some example data since the demo data is included
with the App and integrated as this utility import menu
option. (i.e. no file selection or download is required)
Please note: this utility adds the imported demo
securities to any securities you may already have within
the App on your device. But if you use this routine just
after installing the App, then there may be no securities
on your device.
If you are totally new to the App and have no existing
securities already stored within FairOption, then we
suggest you choose this ‘Import Demo Securities’ menu
option when getting started.
Remember that securities are all removable anyway,
either by deleting them one at a time, or simultaneously
all in one go, with the ‘Delete All Securities’ utility option
below.

⁃

Delete All Securities: This deletes all your FairOption
securities within the App storage on your device. And
once deleted, they really are gone! And even if you have
multiple Apple devices using FairOption. Remember when
using the App on multiple devices, that the securities data
automatically syncs between all your Apple devices that
use FairOption, which means if you edit a security on one
device, it promptly updates to all devices. And if you
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delete a security on one device, it deletes that security on
all devices. Are you just working with cloud data then?
No. Your data is local device data, but any changes do
promptly sync via iCloud giving you the best of both
worlds. Therefore if you have no connection, you still
have the latest data that you previously had on the device
you are using.
You may want to use this ‘delete all’ utility before doing
any full restore to a previously exported JSON backup
file, made on a particular date (all export files are
automatically dated by default, even within the filename!).
You could restore on one device (Mac or iOS) and then all
devices will automatically soon reflect that same restored
data if they have been properly logged in to your Apple
iCloud account. e.g. can receive iMessage, email etc.
You may, for example also want to use this ‘Delete All
Securities’ utility later after previously importing the demo
data and getting familiar with the app, but now wanting to
‘start afresh’ by adding your own securities of interest.
(Alternatively, just manually delete the securities ‘one by
one’ as required).
This ‘Delete All Securities’ utility routine mostly applies to
situations where you have quite a number of securities
stored within FairOption that you wish to delete quickly
‘all in one go’.
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Add or Edit Security
-

The Add Security (‘+’ icon) and Edit Security ("
icon) functions both involve the same input forms
and parameters. So they will both be covered
together in detail here:
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All Devices have the same input parameter fields (On Apple
Watch you will need to scroll input fields using normal Apple
Watch input methods such as ‘drawn character input’ or
microphone voice recognition.)
Any data you enter or edit on iPhone/iOS or Mac will
automatically be synced to other devices, and visa versa.
Please note: On iOS/iPhone (including iPad) and Apple Watch,
before any editing of securities is possible, you will need to
enable edit mode via the # icon, and then select a security to
edit. Edit mode is confirmed as enabled when the #icon
flashes green.
On Mac, to edit a security, just make sure the security you
wish to edit is highlighted in the left securities list and then
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select the # icon. No edit mode is needed on any device in
order to Add Securities.
▪

Security Name: Self explanatory. Describe the security
however you wish but be mindful that you may later wish
to search for the name.

▪

Security Symbol: This ticker symbol is currently only
used for reference/identification purposes and these
symbols are commonly exchange dependent. However,
this field may be used more extensively in future releases
of FairOption.

▪

Stock or Index: Tap/Click on the selection that matches
the current security being added or edited.

▪

Security Price: Enter the underlying stock price or index
value here. Do not be concerned with entering unit
symbols such as £ or $. The options results will
commonly be priced in the same units as the underlying
price. (But do refer to specific contracts)

▪

Security Dividend: This should be the continuously
compounded dividend rate (in % per year) associated
with the underlying security. For an index you may wish to
use a market average dividend rate for the stocks
comprising the particular index. Please note that
FairOption uses this dividend rate you input here in both
Binomial and Black-Scholes model calculations. The
original Black-Scholes model (1973) was only able to
value options on non-dividend paying stocks. However,
FairOption uses the extended Black-Scholes-Merton
model which was expanded to value stocks paying
continuous dividends. Call options values will likely fall
slightly prior to any dividend being paid and put options
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will likely increase. But these adjustments due to
dividends will commonly be priced in over time and
overshadowed by other factors, unless the dividend is
large in percentage terms.
▪

Security Volatility: This is probably the most subjective
and problematic input parameter in option pricing
calculations. But it is an important determining factor in
final theoretical option price results. It needs to be a
representative value for the security’s annual % volatility
between now (when the option is priced) and the time
when the option expires. So at best, it will always be ‘a
forecast’.
You could look up the historic volatility for the security
over time and make an estimation from those figures,
perhaps giving more weight to more recent historic
volatility figures. i.e. calculating the assumed future
volatility upon a statistically smaller number of more
recently observed price movements. But shorter term
(increased or decreased) volatility for a security commonly
does not last forever and a return to what is normal for
the security commonly occurs sooner or later.
Another method is to use an implied volatility figure. i.e.
take a sample of real option prices available to trade, and
then calculate what volatility figure those actual option
prices imply via the models. (In FairOption, you would just
‘play with’/iterate the volatility input parameter until the
theoretical option price results match closely with the real
market option prices.
But do be aware that if the real option prices you base
this implied volatility figure on, are inflated or less than fair
value, then similarly will be any theoretical option pricing
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you base on your new implied volatility figure. Also be
aware that real option prices contain a sentiment/
expectation/fear element that encompasses human
emotion, and what sellers and buyers forecast for a
particular security.
In any event, the input volatility figure needs to be an
annual % volatility figure for the particular security. (This
equates to the standard deviation of stock/security
values.)
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▪

Option Exercise Style: Select either European (option
exercise only possible at expiry) or American (exercise
allowed at any time before expiry). Please note: When
pricing American exercise-style options, then the slower
Binomial calculation model is preferable because it
accounts for the possibility of early exercise. Early
exercise of American Options can be likely in situations
where an option is deep ‘in the money’, to prevent a
trading position reversal (i.e. to lock in a ‘paper profit’) or
sometimes for transactional or tax reasons.

▪

Option Cycle: Tap/Click to set the main expiry cycle for
options available on the specific security. E.g. It could
commonly be Monthly or the 1st, 2nd, 3rd month of
quarter cycle, depending on the options available to you
for the security on a particular exchange.

▪

Option Expiry Day: There are currently two expiry day
choices available (This is the day that options expire for
the security within the various expiry months): The third
Friday of the month, or the last weekday of the month.
(Both at 4pm)

▪

Add Weeklys: This switch allows you to automatically
add shorter-term Weekly option expiry dates (and
therefore corresponding option results) to the main option
cycle expiry dates you have already set for the security.
Weekly options are commonly the same as monthly
options in all respects, apart from they only exist for
about 8 days. They are introduced on Thursdays
(sometimes late on Wednesday) and expire on Fridays,
about 8 days later. (Not just on the third Friday of the
expiry month). So FairOption currently inserts a
maximum of two weekly options if this ‘Add Weeklys’
button is set for the security.

- 49 -

Please Note: The App is intelligent enough to realise if
any Weekly Option expiry date coincides with a Friday
expiry date already generated from the main option cycle
specified for the security, and will not duplicate those
expiry date columns. (This also applies to LEAPS options)
▪

Add LEAPS: This switch allows you to automatically add
longer-term trade LEAPS option expiry dates (and
therefore corresponding option results) to the main option
cycle expiry dates you have already set for the security.
The only diﬀerence between LEAPS options and other
options is that they have longer times to expiration
(commonly a year or more.) If you turn the ‘Add LEAPS’
switch on for a security then FairOption may
automatically add two LEAPS expiry dates to the option
results grid or table, expiring on the third Friday of month
of the next coming January at 4pm. (and the also the next
January after that).
Please Note: The standard Monthly ‘Option Cycle’
setting provided, even without this ‘LEAPS addition’,
already commonly generates more than a year’s worth of
expiry dates (and more than three years of expiries if a
quarterly Option cycle is selected). So you may find this
‘Add LEAPS’ facility unnecessary if it is already covered
by the dates generated.
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Important
-

Important - Please Note Carefully.
Although Option trading in combination with other underlying
financial instruments can be used to lower the risk/gearing of an
overall investment strategy, it is otherwise commonly a more highly
geared (risky) way of trading and hence best done by
professionals, or by investors with (and after) the help of
professional independent financial advice.
FairOption™ and its developer in no way purports to provide that
professional advice and it must be stressed that any theoretical
option price (such as calculated by the FairOption™ software
calculator tool and the mathematical models it uses) is just that. i.e.
It is a useful indicative tool to indicate the theoretical fair option
price of traded options. Yes, it commonly can if used properly
provide a useful indication as to whether a particular option is fairly
priced, overpriced or may be cheaper,
However there are factors that can never really be fully included in
such models:For one Example: It is widely accepted that the premiums asked
by 'human' option writers for deep 'in the money' and especially
deep 'out of the money' calls and puts are often larger than what
would be expected by the theoretical calculated 'fair option prices'
alone. This is commonly referred to graphically as 'the volatility
smile' amongst professionals, and may well be due to the 'fear' of
option writers of large underlying stock or market movements (and
however unlikely they may be) at times of increased uncertainty/
volatility when the assumption of constant volatility within the
models may not apply. It must also be noted that the accuracy of
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all such models is to a large extent dependent on the values for the
assumed or calculated volatility figure input into those models.
FairOption™ does not calculate volatility values and therefore
needs appropriate input for that particular, important and relatively
subjective variable. (See Add or Edit Security for more information
on the volatility input parameter)
Additional to the above: The individual circumstances of particular
investors will also be relevant to whether options are in any way
suitable for being any part of their overall investment strategy, as
judged by the investor after advice from their own chosen
independent financial advisor.
Neither Apple nor the developer of FairOption™ can possibly be
aware of the individual detailed circumstances of app users and
therefore it is strongly recommended and emphasised to users of
this App that they do take careful note of all these highlighted
factors. i.e. Just as a 'power tool' in either the wrong or
inexperienced hands (or without professional advice) can be 'a
dangerous thing', trading in complex instruments such as options
is not safe for inexperienced individuals.
In fact, all trading is inherently risky under any circumstance. After
all, if we could all make automatic profitable returns without any
risk then where (or from whom) would all those returns come from?
So please be aware that FairOption™ is purely a good
indicative calculator tool intended for professionals or those
who are both experienced and knowledgeable in such matters.
Please also see:

Terms and Legal
Our Privacy Policy
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Terms & Legal
-

Terms and Conditions
•

This Software, FairOption™ is provided 'as is', without
warranty of any kind, whether or not expressed or implied,
including but not limited to the warranties of merchantability,
fitness for a particular purpose and non-infringement. In no
event shall the developer, author(s) or copyright holder(s) be
liable for any claim, damages (even if pre-advised of such
possibility), negligence or other liability, whether in an action
of contract, tort or otherwise, arising from, out of, or in
connection with this software, or the use or misuse of it, or
any and all other dealings in this Software.

•

FairOption™ is supplied only as an indicative tool for the
theoretical pricing of traded options.

•

No financial advice is provided or implied by FairOption™ or
anything connected with the product.

•

Neither the Developer nor Apple can possibly be aware of the
individual financial circumstances of users of this Software
product and therefore users are strongly recommended to
seek professional financial advice before any consideration
for trading in options, complex instruments or other inherently
risky investment products. Please also refer to ‘Important Please note carefully section’.

•

Neither FairOption™ nor its Developer are a market data
distributor and neither aforementioned party is responsible for
the quality, availability, or cost of any such service chosen by
any customer to be used in any combination with this
software. Any such data services are completely out of the
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control of FairOption™ and its Developer.
•

English Law applies with the exception of the UN Convention
on Contracts for the International Sale of Goods.

•

All trademarks are acknowledged.

•

Copyright © 2014-2022

Please also see:

Our Privacy Policy.
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Privacy Policy
-

Overall
We take your privacy seriously and this privacy policy informs you
about what personally identifiable data is collected via the
FairOption App and related support services. Also how we may
hold, use, share and protect your data.

Your Personal App Data
We do not collect (or even have access to) any data you enter into
the FairOption App. Your App securities data is stored on your
own Apple device(s) and optionally within your own Apple iCloud
account for syncing purposes. (Again, we have no access to your
private database facility within iCloud.) Apple iCloud data may be
stored in the United States. See Apple documentation on their
Privacy Policy with respect to iCloud data. Only you can
authenticate access to your Apple iCloud account data and we
understand it to be extremely secure.
In terms of FairOption: there is no real personal data stored by the
App anyway since security names and prices are already within the
public domain and option results data is generated ‘on the fly’. i.e.
never stored in any permanent form, unless you choose to export
that generated data to a file of your choice. But again, it is not
private data referenced to yourself, since it contains only
theoretical option price values based on public domain data. This
means that we can never provide you with a backup of your own
data for restoration purposes. The App provides a facility for you to
perform your own security backups and you will need to perform
file backups and store them appropriately where you choose.
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Support Data
The only personal data we would have ourselves concerning a
FairOption App user would be in connection with a support request
initiated by a FairOption App user and made to us via email or
some other method. All such data (including email data) is treated
appropriately and securely and only used for the intended
purposes of providing support and related information to a
FairOption user. i.e. we have no access to any of your data unless
you volunteer to provide it to us, when in such circumstance it will
always be treated respectfully and not shared without your
permission.
We do not collect any personally identifiable analytics data from
The FairOption App, but Apple devices do have the optional ability
to collect anonymous data about ‘a crash’. (i.e. when an App stops
working with some problem). You can choose whether or not you
wish to share this anonymous crash data via the Apple device’s
Operating System. Apple may then share this anonymous data
with us in order to identify and fix any problems with the App and
to make improvements.
Please note: that you would need to have actively enabled the
option(s): ‘Analytics and Improvements’ and ‘Help App Developers
improve their Apps’, in the Privacy settings of your own Apple
device for any crash report Data to be available to Apple and to us
as a Developer. In any event, it is anonymous data.

How to Delete Your Data
You can delete all your FairOption App securities data by using the
‘delete all securities’ button available in the ‘Utilities’ menu on IOS
or macOS. This will still leave the App installed. To totally delete the
App, follow Apple’s instructions for deletion of an App on your
chosen device. Whilst deleting the App, you should also receive a
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choice to completely delete the App’s data as well, but we suggest
you also use our Utility before deleting the App since that will make
sure that any iCloud sync data is also deleted. You will need to
manage any App data exports you have made concerning
securities and/or option results. i.e. you will need to delete these
personal CSV and/or JSON files yourself if you choose.
As far as any Support Data is concerned:
▪

You can contact us at any time to request what data is held
concerning you and also ask for that data to be deleted. You
may also challenge the accuracy of any such data and
request amendments to be made to it, if it is inaccurate.

▪

Similarly you can do the same as above with sales
transactional data (E.g. if you have purchased the Mac
version of FairOption directly from us or via a payment
provider (e.g FastSpring vs directly from the Apple App
Store). But do please appreciate that we are only able to
confirm data that we actually store, and even then we are
required by law to store certain transactional data for a
reasonable period of time.

▪

If you visit our website at FairOption.com, you may also
choose to supply personal data and data related to sales,
support and your use of the FairOption App. All such data will
be treated in the strictest confidence and as already
described above, be subject to any of your requests to
confirm, amend or delete such data. Our website, like most
websites may also collect anonymous usage data via the
Google Analytics service provided by Google Inc. and its
partners. You can control whether or not to accept new
cookies and also delete existing cookies using settings within
your computer’s browser. Please refer to Google’s privacy
policy for more information.
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Third Parties
This privacy policy does not cover third party services, websites,
content, or any other Apps not developed by ourselves. The
privacy and security policies of other organisations and entities are
completely outside our control.

Updates to this Privacy Policy
This privacy policy may be updated from time to time, but was
updated here last on 6 Aug 2022.

Further Questions
If you have any queries concerning this Privacy Policy, then please
contact support@fairoption.com
Please also see:

Terms and Legal
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Acknowledgements
-

We would like to acknowledge pioneers without
whom The FairOption App would probably not be
possible. The tried and tested formulas and
advanced mathematics behind the App are build
upon the shoulders of geniuses who completely
focused on ‘the goal’, whatever ‘the distractions’
in life:
-

Jacob Bernoulli (1655 -1705) - A Swiss mathematician from
a renowned family of mathematicians celebrated for his
contributions to calculus and for discovering the fundamental
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‘e’ number constant when researching a problem concerning
compound interest. (FairOption numerously makes use of the
‘e’ number in calculations)
Jacob Bernoulli was also highly renowned for his original
important work on mathematical probability which in 1713 was
finally published in a book called ‘Ars Conjectandi’, eight years
after his death from his papers, by his nephew, Nicolaus
Bernoulli.
The Bernoulli impact crater on the moon is named after both
Jacob and his brother, Johann.

Leonhard Euler (1707 -1783) - A Swiss wide-ranging
mathematician who was one of the most published
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mathematicians. From an early age he was trained by his
father, who had previously taken courses from Jacob Bernoulli
at Basel University. From the age of 13, Leonhard Euler
attended Basel University on a course provided by Johann
Bernoulli, the younger brother of then deceased Jacob
Bernoulli. Euler’s work spanned nearly all areas of
mathematics, and maybe accounting for a quarter of the
authored output of 18th century published maths, mechanics,
physics, astronomy and navigation combined. He introduced
and/or popularised many mathematical notations including the
idea of a function being written as f(x), showing a function f,
applied to variable argument, x. And the Greek letter Sigma to
denote sum, i to denote imaginary numbers and established
the Greek letter Pi to stand for the circumference to diameter
ratio of a circle. (A Welsh mathematician was actually the first
to use the Greek Pi notation, and ancient civilisations
discovered the actual number to lesser accuracy).
He named the letter e (know as Euler’s number), and
calculated e (the base of all natural logarithms) to more
decimal places than previous (although Jacob Bernoulli
discovered its existence and what the constant number
actually was.)
Euler’s eyesight got worse during his mathematical career and
in 1738, after an illness, he was almost blind in his right eye. It
got worse and Euler stated that now he had fewer distractions.
In 1766 a cataract was then discovered in his left eye, and the
failed surgery that followed now left him almost totally blind.
Despite this, his productivity seemed not only to maintain, but
even increase in many areas. In 1775 he was releasing one
mathematical paper every week.
Euler had a brilliant mind and has left a legacy in numerous
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practical areas of maths, engineering and physics that help all
of us today.

Louis Bachelier (1970 -1946) - This French mathematician
was the first to model the stochastic process (later known as
Brownian motion) and use it to value stock options and
describe the way they move. This Bachelier model influenced
development of later financial models such as The BlackScholes model. Bachelier was the first to use advanced
mathematical models in the area of finance.
Both of Louis’s parents died just after he completed high
school, necessitating him to be a carer for his younger siblings,
run the family business and delay his graduate studies (with

- 62 -

then yet further delay due to his World War I military service.)
But despite all this, and his grades not being particularly good,
he was eventually recognised after several decades as the
original pioneer of the random walk theory (preceding
Einstein’s related study of Brownian motion by 5 years.)

Fischer Black (1938 -1995) - An America economist most
renowned as co-author of the Black-Scholes Option pricing
formula. Black graduated from Harvard in 1959 and received a
Ph.D in applied mathematics in 1964 from the University. He
was also very interested in computers and artificial intelligence.
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Black and Myron Scholes published the paper ‘The Pricing of
Options and Corporate Liabilities’ in 1973, which contained the
Black-Scholes equation.
Fischer Black was also an early recogniser of the Business
cycle and why these economic ups and downs occur.
In 1997 The Nobel Prize for Economics was awarded to Robert
C Merton and Myron Scholes, Black’s co-author of the BlackScholes, for their ground-breaking work on option pricing.
Black was not awarded the prize because he had died from
throat cancer two years earlier, and The Nobel Prize is not
awarded posthumously. But the Nobel Committee prominently
mentioned Black’s key role in the work on options.
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Myron Scholes (born 1941) - A Canadian economist who
together with Robert Merton, received The Nobel Prize for
Economics in 1997 for their work on option pricing, and
together with Fischer Black, was co-author of the BlackScholes Option Pricing Equation.
After taking an academic position at MIT Sloan School of
Management in 1968, Scholes met Fischer Black and later
Robert Merton there in 1970. And over the following years, all
three did pioneering research on the valuation of assets
(including option pricing.)

Robert Merton (born 1944) - An American economist who
together with Myron Scholes, received The Nobel Prize for
Economics in 1997 for work done on determining the value of
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derivatives. i.e. a method and framework for valuing financial
instruments based on underlying security values. Merton was
also key in expanding the original Black-Scholes option pricing
model to cope with dividend paying stocks.

John Cox, Stephen Ross, and Mark Rubinstein - We would
also like to acknowledge these three pioneers who first
proposed and developed the binomial tree/lattice model for
option pricing in 1979. This then new iterative pricing model
provided more flexibility by addressing some of the
deficiencies inherent in the earlier 1973 Black-Scholes model,
such as the eﬀects of early exercise, and so it opened the way
to pricing American exercise-style options.

- 66 -

Extra Tech Info
-

In terms of openness and providing extra relevant
information to our FairOption App customers:
We wish not only to communicate to customers about App
features we know are useful, but also wish to be transparent
about some areas which may warrant improvement
(dependent on the latest technologies available) together with
some explanation of design decisions made, some of which
may be based on limitations presently outside our control:
•

Table/List option view (Mac only): The table/list view of
options (available only on Mac) allows 10 columns of
information for each option. (i.e. not all calculated Greeks
are included in that displayed list of columns). But clicking
on any table row will then reveal all the Greeks we
currently calculate in the right window pane. Additionally,
any export to a CSV or JSON file from the sorted table
will also include all calculated option fields. (We believe
that this is due to a limitation of SwiftUI to display more
than 10 table columns on Mac). In our view, Apple has
been proactive at developing and promoting SwiftUI, but
as with any newer framework, there are many
advantages, together with some things that take some
time to improve.

•

Automatic underlying security price update: A
previous version of FairOption did have the optional
ability to automatically update a security’s underlying
price value based on Finance APIs such as Google and
Yahoo, subject to a live connection. However both APIs in
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our view were not consistently developed and/or
supported clearly, and were then oﬃcially retired over
previous years. We also want our App to be consistent
and reliable. So currently we feel on balance that the
manual updating of the current underlying stock or index
value prior to option pricing is the best and most
independent method. i.e. It takes about 5 seconds or
less to update a single underlying security price, which
then immediately facilitates display of hundreds of call
and put option results on all devices. However, the
inclusion of features like this are kept under constant
review.
•

No App Settings sync: All securities data can be
automatically synced across all your Apple devices when
the devices are logged in to your same Apple iCloud
account. We did consider similarly syncing App settings
too. However, there are very few App setting/preference
parameters which would benefit from being automatically
synced and there are several situations where such
automatic propagation of settings would be undesirable.
For example: there is more computing power on a Mac
vs an Apple Watch and therefore it is possible you may
wish to set the number of binomial calculation steps to a
higher number on Mac. And security Defaults, once set
as desired, will probably not change often. The ‘Test Calc
Mode’ would likely be used temporarily and infrequently,
and commonly only on a single device. i.e. you may well
not want it to sync.
So on balance, it was decided not to sync the FairOption
App settings and therefore you will need to set the small
number of setting appropriately on each individual device
and change them as required.
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•

Securities List sync requirements: Please note that
FairOption’s automatic syncing of the security list
between Apple devices reflecting new additions, edits,
and deletions will only properly occur if you are logged in
to your Apple iCloud account, and for iPhone or Watch,
allow the FairOption App to use available iCloud storage
in the device’s iCloud Settings. (This should be the
default upon installation of the App).
Otherwise any security list changes you make on a device
will only be reflected on that single device alone and will
not update to any other Apple devices you use FairOption
on, until you are again logged in to Apple iCloud and
allow the App to use iCloud storage via the device’s
iCloud settings.
On iPhone and Apple Watch, you will also need NOT to
disable both ’Background App Refresh’ and ‘Mobile
Data’ in the device’s App settings, if you want syncing to
seamlessly occur, even when the App is in the
background and not being currently used.
Similarly on Mac: for syncing you will need to be logged
in to iCloud and in System Preferences make sure iCloud
Drive is enabled for the FairOption App. (This should
normally be the case unless you have overridden or
disabled the setting).

•

App Launch: On launching the FairOption App on any
Apple device, the FairOption logo is displayed for about 2
seconds before the App can be used. Please note that a
tap or click anywhere on that initial logo screen will
immediately dismiss the logo screen and enter the App’s
security list earlier.
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Support and Feedback
We welcome feedback and suggestions concerning
FairOption™ and please contact us if you have any problems.
Our website is at www.FairOption.com
Please email: support@FairOption.com stating your name,
Apple device(s), FairOption App version and your device’s OS
version, together with a description of the problem. Or
communicate details of any new feature(s) you would like to be
considered for inclusion in a future release.

For help or suggestions: please email
support@fairoption.com
Website: www.FairOption.com
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